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Task 1 – Task panes, menus and toolbars

1. Display the task pane if it is not already visible.

2. Now close the task pane.

Using Menus
3. Click on View menu.

4. Click on the double arrow at the bottom of the menu to expand it.
5. Is the Ruler ticked? Click Ruler to tick or untick it. (The Ruler bars will either reappear or disappear from your screen.)
6. Use the keyboard to open the View menu by pressing Alt+V.
7. Note that Footnotes and Comments are greyed out.  Why is this?
8. Point to the Toolbar option to view the Toolbar sub-menu. How many items are selected?
9. Point to the Insert menu.
10. Note that there are several items with ellipsis after them … They will all have there own dialog boxes when selected.
11. Move the mouse pointer slowly across the names of the other menus on the Menu bar to view these menus. Note that, once one menu is expanded, all the other menus will be expanded also.
12. Click anywhere on the screen to close the menu.
13. Open the Edit menu. Note that several options have shortcut keystrokes listed next to them, eg, you could have pressed Ctrl+F to activate the Find feature instead of using the Edit menu.
14. Press Esc to close the menu.
15. Point the mouse at the centre of your document screen and click the Right mouse button. A shortcut menu will appear.
16. Click the Left mouse button away from the menu to close it. Remember that pressing Esc will also close menus.

Using Toolbars
17. Right click anywhere on the toolbar to display the toolbar options.
18. Left click on Drawing to display the Drawing toolbar. Note that it appears at the bottom of your document screen.
19. Right click on the Drawing toolbar and Left click on Drawing to remove it from your screen.
20. Press Alt+V to display the View menu. Click on Toolbars to display the dialog box.  Select Table and Borders.
21. This toolbar will be displayed as a floating toolbar. You can drag the title bar of the toolbar and place it anywhere on your screen. Click on the Close button on the toolbar title bar to close it.
22. Click on the double arrow to the right of the Standard toolbar to display more toolbar buttons.
23. Click on Add or Remove Buttons to display a list of Standard toolbar buttons. Select (or deselect) the buttons you want to appear on your toolbar. 
24. Click away from your toolbar to deselect it. 

Task 2 – Typing practice

If you are new to word processing, you will probably benefit from some typing practice and need to do this entire task. Otherwise you can move on to section 4 (Editing a document).

25. Enter the following text in a new document:
Jeremy Bentham

The philosopher and jurist Jeremy Bentham (1748-1832) was born at Houndsditch, London, on 15th February 1748. He proved to be something of a child prodigy: while still a toddler he was discovered sitting at his father’s desk reading a multi-volume history of England, and he began to study Latin at the age of three. At twelve, he was sent to Queen’s College Oxford, his father, a prosperous attorney, having decided that Jeremy would follow him into the law, and feeling quite sure that his brilliant son would one day be Lord Chancellor of England.

Bentham, however, soon became disillusioned with the law, especially after hearing the lectures of the leading authority of the day, Sir William Blackstone (1723-80). Instead of practising the law, he decided to write about it, and he spent his life criticising the existing law and suggesting ways for its improvement. His father’s death in 1792 left him financially independent, and for nearly forty years he lived quietly in Westminster, producing between ten and twenty sheets of manuscript a day, even when he was in his eighties.

26. Save the file with the name jeremy.doc on the R: drive in the training.dir\word\getting-started folder.
27. Close the file.


You are now ready to do Exercise 1.
Task 3 – Moving around a document

28. Open the file bentham.doc on the R: drive in the training.dir\word\getting-started folder.
29. Use the Page Down key to find the paragraph beginning: Even for those who have never read...
30. From this position, using the keyboard, move one word at a time to the text Bentham.
31. Using the keyboard, move to the end of the document in one keystroke. What is the last word in the document?
32. Using the mouse, move to the heading The Auto-Icon.
33. Using the mouse, move to the start of the document. What keyboard shortcut could you have used to carry out this operation?
34. Using the Go To command (on the Edit menu), move to page 2. What is the keyboard shortcut for this command?

Task 4 – Basic editing

The file bentham.doc in the r:\training.dir\word\getting-started folder is used in this task.
Correct the line spacing as you complete the tasks to maintain a line break between paragraphs.
35. Cut the heading The Auto-Icon and use the Clipboard task pane to paste it above the paragraph beginning: At the end of the South Cloisters... (the paragraph above).

36. In the fourth paragraph down from the heading The Auto-Icon, the one beginning: Not surprisingly, this peculiar relic has... Add the following sentence to the end of the paragraph:

In these cases the Auto-Icon invariably votes for the motion.

37. The last two paragraphs in the document are in the wrong order; reposition them so that the paragraph starting: Many people have speculated as to exactly why Bentham...  is the last paragraph.

38. Copy the heading Jeremy Bentham at the top of the document and paste it to form a new heading above the paragraph beginning: Bentham is often credited with being one of the founders of the University of London...  (the fifth paragraph down).

39. Now copy both of the headings in the document (The Auto Icon and Jeremy Bentham) at once using the Ctrl key to select them simultaneously. Open a new, blank document and paste the copied headings into it using the Clipboard task pane. Notice that all items which you have copied or pasted in the bentham.doc document are now available on the Clipboard task pane in the new document.

40. Close the new document without saving it, but save the bentham.doc file.

You are now ready to do Exercise 2.
Task 5 – More basic editing

The file bentham.doc in the r:\training.dir\word\getting-started folder is used again for this task.

41. Add the text and UCL to the Jeremy Bentham heading you have just copied so that the new heading reads Jeremy Bentham and UCL.

42. Now change this heading by overtyping the existing text (Jeremy Bentham and UCL) and replace it with the heading UCL and the Founding Father.

43. In the paragraph above, delete the sentence beginning: Research into his work continues at UCL in the Bentham Project... . (Remember that you can select the sentence and delete in one action.)

44. Undo all of the above steps in one go, i.e. back to the point where the subheading is returned to Jeremy Bentham and UCL. 

45. Save the file with the same name – bentham.doc.
You are now ready to try Exercises 3 and 4.

Task 6 – Find and replace

The file bentham.doc in the r:\training.dir\word\getting-started folder is used for this task.

46. The name Jeremy has been misspelled as Jeremey in several places in the text. Using Find and Replace, correct these mistakes.

47. The word college as it occurs in the text should be capitalised. Replace the word college with the correct capitalisation College throughout the text.

48. Find the word defiant and replace it with the word pugnacious.

49. Find the word utilitarian and replace it with the word pragmatic (take care not to replace the word utilitarianism).

50. Save the file with the same name – bentham.doc.

You are now ready to do Exercise 5.

Task 7 – Spelling

The file bentham.doc in the r:\training.dir\word\getting-started folder is used for this task.

51. Position the insertion point at the top of the document.

52. Spell-check the document. There are a number of spelling mistakes in the document. Correct the mistakes. Listed below are some of the errors that the spell-checker will identify:

· The name Bentham is identified as not being in the dictionary. Choose Ignore.
The spell check will pick up the same name ‘Bentham’ again. Choose Ignore All to prevent this from happening or Add the word to the dictionary. The same problem occurs with the text Bentham's.

· The word contractarianism has been identified as not in the dictionary, Add this word to it.

· The word as has been repeated in the text, delete the second occurrence.

· There are several names Tonks, Flaxman, Wilkins... which are identified as not being in the dictionary, choose to Ignore these names.

· The word nda is identified. There are no suggestions for this word. Retype the text in the Change To box – it should read and.
· The word his has been repeated in the text. Delete the second occurrence.

53. Save the corrections and close the file.

You are now ready to try Exercise 6.

Task 8 – Character formatting

The file bentham.doc in the r:\training.dir\word\getting-started folder is again used for this task.

54. Select the whole document and change the document’s font to Palatino and point size to 12.

55. Format the headings in the text (there should be three) so that they are bold and italic.

56. Format the credit at the end of the document so that it is italic.

57. In the third paragraph: Even for those who have never... select the quote at the end of the first sentence: the greatest happiness of the greatest number. Format the quote using the AvantGarde font and italicise the text.

58. Using the Format Painter, paste the format used above and apply it to the credit at the end of the text.

59. Change the format of the title Jeremy Bentham to the Garamond font, 16 pt, bold and remove the underlining.

60. Paste the above format to the other headings in the document. (Remember to double-click on the Format Painter button, when a format is to be copied more than once.)
61. Save the file with the same name: bentham.doc.
You are now ready to try Exercises 7, 8 and 9.

Task 9 – Paragraph formatting

The file bentham.doc from the R: drive in the training.dir\word\getting-started folder is used in this task.

62. Select the whole document and, using a button on the toolbar, change the line spacing from single to 1.5 lines.

63. Fully justify the text using a button on the toolbar.
64. Move to the bottom of the document, leave a couple of empty lines and add the text::

For further information visit the UCL Web site.

65. Format the text to make it bold and italic.

66. Save the file with the same name: bentham.doc.

You are now ready to try Exercise 10.

Task 10 – Views and page setup

67. Using the document bentham.doc, familiarise yourself with the different viewing modes by switching between them.

68. What view are you in if:
· the horizontal and vertical rulers are visible, page breaks are represented by areas of grey shading on the screen, and margins are represented by shading on the rulers and defined in white on the document page?

· the document occupies the full screen and there are no other screen elements?

69. Find out how a page break is represented on screen in Normal view.

70. Go to the File menu and click Page Setup. Change all the margins (top, bottom, left and right) to 3cm (1.18").

71. Set the orientation to landscape for the whole document.

72. View the document using Page Layout view.

73. Set the orientation back to portrait for the whole document.

74. Use the Zoom control to zoom in and out of the text to gain a different perspective of the document. What is the largest zoom and the smallest zoom available?

75. What zoom percentage is the screen displayed at if you select Page Width from the Zoom menu?

76. Close the document without saving it.

Task 11 – Page breaks and numbering
In this task you will again work with the file bentham.doc.

77. Insert a page break at the top of the document.

78. Enter the following text on the new page:

Jeremy Bentham

“Our Spiritual Father”

University College London 

(c) Copyright 1997

(Notice how the (c) changes to a © symbol).


79. Format the text using the Garamond font, point size 28.

80. Insert the page number at the bottom centre of the page.
81. Save and close the file.

Task12– Multiple files and file formats

82. Open the file bentham.doc.

83. Save the file in plain text format. What do you notice?

84. Close the file.

85. Open the file part1.doc.

86. Move the insertion point to the end of the document and insert the part2.doc file.

87. Close the document without saving it.

88. Open both the files part1.doc and part2.doc.

89. Make sure that part1.doc is the active window.

90. Select all the text in this file and copy the text.

91. Switch to the file part2.doc and paste the text at the top of the document.

92. Save the file as final.doc and close it.

You are now ready to try Exercises 11 and 12.

Task 13 – Help

93. Use Microsoft Word Help to find help on the different types of help available.

· From the Help menu click Microsoft Word Help. Select the Answer Wizard tab
· Type Help in the What would you like to do? box and click on Search.

· Select the option How to get help while you work.

· Read the entry on screen tips.

· Select the Contents tab.

· Look at the entry on Viewing and Navigating Documents.

Notice as the options displayed in the second box change.

· Now select Move around in a document from the list of sub-topics.
· Select the Index tab.
· Look for help on Toolbars.
· Is it possible to move a toolbar?

94. Experiment with the buttons in the Help window. For example, use the Hide button, the Back and Forward buttons and the AutoTile button to see what they do.

95. When you are confident that you understand how to use the help system, close the Help window.

Further Exercises

Training files

If you wish to attempt the following exercises and you are not using a training account it is necessary to download the training files used in this workbook from the IS training Web site at: http://www.ucl.ac.uk/is/training/exercises.htm
Full instructions on how to do this are provided on this Web page.

The downloaded files will be copied to a folder on the R: drive (unless otherwise specified) into the r:\training.dir\word\getting-started folder.

Exercise 1 – Creating a document

Unless specified otherwise, all files for the following exercises can be found in the training accounts in the r:\training.dir\word\getting-started folder.

96. Enter the following text into a new document:

The Best Training Solutions

Many professionals are too busy to work through a complete training course in a single sitting. Our highly acclaimed Professional Survival Guide addresses this problem by providing you with quality training in bite-size pieces in a just-in-time format.

Designed to be a constant companion, the guide is broken down into separate sections covering different survival tactics for all situations. These sections can either be studied independently or in sequence just as required. In addition every section is built around a checklist which you can print out and use as a handy reminder when you are away from your desk.

97. Save your file with the name best1.doc on the R: drive in the training.dir\word\getting-started folder.

98. Close the file.

Exercise 2 – Editing

99. Open the file you created in the previous exercise r:\training.dir\word\getting-started\best1.doc

100. Add the following text to the bottom of the document:
To receive your FREE evaluation copy it will take only a few seconds to complete and return the enclosed, reply-paid slip. Alternatively, just give me a call on 01232 456 8756.

The course will be invaluable for all professionals in your organisation needing to brush up on their skills.

Yours sincerely

101. Save the file again, this time use the Save As command and rename the file best2.doc in the folder r:\training.dir\word\getting-started

102. Close the file.

Exercise 3 – Further editing

103. Open the file best2.doc (created in the previous exercise) from the R: drive in the training.dir\word\getting-started folder.

104. Reposition the insertion point at the top of the document and insert the following text:

Dr S Tatler

St James's Court

London

W1N 4DT


Press the Enter key at the end of each line of the address and three times at the end of the address to create three new lines before the salutation.

105. Type the salutation:

106. Dear Dr Tatler 
and press the Enter key twice.

107. Reposition the insertion point at the end of each paragraph and insert a blank line.

108. Reposition the insertion point at the end of the document and insert four blank lines (to leave room for a signature).

109. At this point in the letter, type the sender’s name Sarah Lyndhurst.
110. Select the text bite-size in the first paragraph and delete it. Replace it with the text manageable.

111. The last two paragraphs are in the wrong order. Reposition them so that the paragraph beginning: To receive your free evaluation... is the last paragraph.

112. Copy the heading The Best Training Solutions and paste it at the end of the document after the signatory.

113. Save the file again with the name best3.doc on the R: drive in the training.dir\word\getting-started folder.
114. Compare your layout with the letter shown at the back of this workbook (we will be formatting it further in the next exercise).

115. Close the file.

Note:
If you make any mistakes remember to use the Undo and Redo buttons.

Exercise 4 – Copying and moving (optional)

116. Open the file time.doc in the r:\training.dir\word\getting-started folder.
The file contains an incomplete and inaccurate timetable for Class 1A. Your task is to complete the timetable to look like the completed timetable shown below, using copy, cut and paste techniques.

	CLASS 1A
	Monday
	Tuesday
	Wednesday
	Thursday
	Friday

	
	
	
	
	
	

	09.00 - 10.00
	Maths
	
	Study
	
	

	10.00 - 11.00
	Maths
	
	Science
	
	

	11.00 - 12.00
	Geography
	
	Science
	
	

	12.00 - 13.00
	History
	
	Science
	
	

	13.00 - 14.00
	Lunch
	
	Lunch
	
	

	14.00 - 15.00
	English
	
	French
	
	

	15.00 - 16.00
	French
	
	French
	
	


117. The classes for the different days have been mixed up:
· Move the classes from the column Monday and paste them to Tuesday.
· Move the classes from the Wednesday column to Thursday.

118. Now copy the correct classes from the columns Tuesday and Thursday and paste them to make up the complete timetable for Monday, Wednesday and Friday. Avoid typing any entries. The completed timetable should be as shown in Fig. 2 below.
Completed Timetable

	CLASS 1A
	Monday
	Tuesday
	Wednesday
	Thursday
	Friday

	
	
	
	
	
	

	09.00 - 10.00
	English
	Maths
	History
	Study
	History

	10.00 - 11.00
	Geography
	Maths
	History
	Science
	Geography

	11.00 - 12.00
	French
	Geography
	Geography
	Science
	Study

	12.00 - 13.00
	French
	History
	Maths
	Science
	English

	13.00 - 14.00
	Lunch
	Lunch
	Lunch
	Lunch
	Lunch

	14.00 - 15.00
	Maths
	English
	Science
	French
	Science

	15.00 - 16.00
	History
	French
	English
	French
	Science


Fig. 2

Exercise 5 – Find and replace 

119. Open the file glass.doc in the r:\training.dir\word\getting-started folder. The file contains an extract from Through the Looking Glass by Lewis Carroll.

120. At the end of the text, type the following paragraph:

There was nothing so very remarkable in that; nor did Alice think it so very much out of the way to hear the Rabbit say to itself, `Oh dear! Oh dear! I shall be late!' (when she thought it over afterwards, it occurred to her that she ought to have wondered at this, but at the time it all seemed quite natural); but when the Rabbit actually took a watch out of its waistcoat- pocket, and looked at it, and then hurried on, Alice started to her feet, for it flashed across her mind that she had never before see a rabbit with either a waistcoat-pocket, or a watch to take out of it, and burning with curiosity, she ran across the field after it, and fortunately was just in time to see it pop down a large rabbit-hole under the hedge.
121. The name Anne has been incorrectly used, using Find and Replace substitute Anne for Alice.

122. Correct the incorrect capitalisation of Sister throughout the text so that it appears in lower case.

123. Correct the name white rabbit so that it is in title case.

124. Find the text tired and silly and replace it with the text: sleepy and stupid
125. Now save the document with the name: glass1.doc
Exercise 6 – Spelling

126. Open the file glass1.doc created in a previous exercise.
127. Spell-check the document. Take care to check the whole document as there are a number of different errors in the text.
128. Save the checked file with the same name: glass1.doc
Exercise 7 – Formatting

129. Open the file glass1.doc created in the previous exercise.
130. At the end of the document insert the paragraph:
131. In another moment down went Alice after it, never once considering how in the world she was to get out again.

132. Move to the top of the document and insert the following headings:


ALICE'S ADVENTURES IN WONDERLAND


by Lewis Carroll


Chapter I


Down the Rabbit Hole

133. Format the headings using the Georgia font, change the main title and author so that they are 18pt and make the remaining headings 14pt.
134. Change the font of the main document text to Palatino, 12pt.
135. Insert a new line between the paragraphs and the main headings and the body text.
136. Remove any underlining in the text.
137. In the first line of the third paragraph, change the format of the two occurrences of the word very so that it is capitalised and appears in italic.
138. Find the text: took a watch out of its waistcoat-pocket… Change the case to upper case and the format to bold.
139. Save the file with the same name: glass1.doc.
Exercise 8 – Formatting (optional)

140. Open the file best3.doc created in a previous exercise.

141. Select all the text and change its font to Arial 14pt.
142. Format the heading: The Best Training Solutions so that it is bold and change the font colour to red.
143. Select the text: Professional Survival Guide in the first paragraph and change the font to Arial Black, and italic.
144. Format the text: constant in the third paragraph so that it is italic.
145. Select the third paragraph: The course will be invaluable and highlight the text using bright green.
146. Format the sender’s name Sarah Lyndhurst so that it is italic.
147. Format the capitalised text FREE in the last paragraph so that it is bold and underlined.
148. Save the file again with the same name.
Exercise 9 – Formatting (optional)

149. Open the file sport.doc in r:\training.dir\word\getting-started

150. Reposition the cursor at the beginning of the second paragraph: Mike Wilson... and insert the text: During the next month.
151. Delete the text: during the next few weeks at the end of the second paragraph. Make sure that the sentence ends in a full stop.
152. Remove the blank line between the second and third paragraphs to form one paragraph.
153. In the paragraph beginning: Customers wishing... the words now have in the second sentence appear the wrong way round. Rearrange the words so that it reads have now.
154. The last two paragraphs are in the wrong order. Reposition the last two paragraphs so that the last paragraph begins: If you would like to complete...
155. Format the heading: NEWBROOK SPORTS COMPANY so that it is bold. Centre the heading.
156. Format the heading: Press Release so that it is italic and bold.
157. Format the headings: Country and Sales Manager so that they are underlined and italic.
158. Remove the underlining from all the headings.
159. Save the file as sport1.doc on the R: drive in the training.dir\word\getting-started folder.

Exercise 10 – Formatting paragraphs

160. Open the document glass1.doc created in an earlier exercise.
161. Align the text in the document so that it is left-aligned.
162. Change the line spacing so that it is double.
163. Save the document with the same name: glass1.doc.
Exercise 11 – Working with multiple documents

There are two files covering the history of UCL. ucl-1.doc details the history of UCL in the 19th century and ucl-2.doc the 20th century. To create a complete history:

164. Open ucl-1.doc from the r:\training.dir\word\getting-started folder.

165. Move to the bottom of the file and insert the file ucl-2.doc.
166. Save this new file as history.doc.

167. The history should be in chronological order. Some of the entries are in the wrong order, so rearrange the appropriate paragraphs:

1827 should be placed above 1829.

1892-1911 should be placed above 1893.

1968 should be placed above 1977.

168. The history is still incomplete. The missing entries can be found in the ucl-3.doc file. Open ucl‑3.doc and copy and paste the entries in this file into the history.doc file in the relevant place. Ensure that all the entries are in strict chronological order.
169. Change the font for the whole document to NewCenturySchlbk, 14pt.
170. Format the title using Bookman Old Style, 18pt, and apply bold and italic.
171. Apply bold to all the date headings.
172. Select the whole document and fully justify the text.
173. Spell-check the document for any errors.
174. Change the top and bottom margins to 3cm and the left and right margins to 2.5cm.
175. Change the line spacing throughout the document to 1.5 lines.
176. Save the file with the same name: history.doc.
Exercise 12 – Page layout and printing
177. Open the file history.doc created in the previous exercise.
178. Insert a subheading: The 19th Century after the main heading and format this using the same font style as the main heading – Bookman Old Style, point size 14, bold and italic.
179. Insert a page break after 1897 and before 1904. Insert another subheading – The 20th Century. Format this in the same way as above i.e. Bookman Old Style, 14pt, bold, italic.
180. Print preview the document, to ensure that the document is ready for printing, making any changes where necessary. (Make sure none of the date headings have become separated from their respective paragraphs and remove any extra line spaces.)
181. Save the file with the name history1.doc.
182. Select the first page only for printing, but do not click OK.
183. Save and close the file
























